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******************* 

1.  INTRODUCTION 

******************* 

 

1.1   PURPOSE OF THIS README FILE 

 

This ReadMe file provides a brief product description and operation overview, installation 

instructions, support information, and software release notes for the hIOmon™ File I/O 

Performance Monitor software product from hyperI/O LLC. 

 

To print this ReadMe file, choose the Print command usually found under the File menu. 

 

 

1.2   DISTRIBUTION AND USE POLICY 

 

Please read the hyperI/O LLC Software License Agreement (EUSLA) for the conditions and 

terms associated with the use (including installing and copying) of the hIOmon software product 

from hyperI/O LLC.  The EUSLA can be found in the “license.pdf” document file; the 

“license.pdf” along with the “license.rtf” and “license.txt” document files (which are all 

equivalent in content) are copied to the installation directory as part of the hIOmon software 

installation process.  The “license.pdf” can be found within the “Documents” directory.   

 

Do not use hIOmon software until you have carefully read this EUSLA.  Copying, installing, or 

otherwise using the hIOmon software indicates that you have read, understand and accept this 

EUSLA and agree to be bound by all of the terms of this EUSLA.  If you do not accept this 

EUSLA, do not copy, install or otherwise use the hIOmon software. 

 

 



1.3   PRODUCT DESCRIPTION 

 

Overview 

 

hIOmon is an innovative, unique performance analysis software tool that enables disk I/O 

operations and their performance to be both measured and monitored up at the application level 

upon a specific, individual FILE (as well as disk and process/application) basis.  It examines and 

efficiently records the performance of user-selected file (and device) I/O operations for real-time 

and/or subsequent display. 

 

The file and device I/O operation information collected by hIOmon can be either: 

 

An “I/O Trace” of the individual I/O operations (i.e., a separate trace record for each and 

every I/O operation being monitored by hIOmon), and/or 

 

“Summary” (i.e., I/O operation performance information automatically aggregated by 

hIOmon upon an individual file, device, and/or process basis for a concise, higher-level 

survey of the selected I/O activity). 

 

Both types of I/O operation information can be viewed (locally or remotely over the network) 

either in real-time and/or in a historical “replay” display mode through the use of the hIOmon 

Presentation Client, which is a Java™-based Graphical-User-Interface (GUI) application. 

 

Summarized performance metrics about selected file I/O operations can also be written by 

hIOmon to the System Event Log for display and other use by popular system management tools 

that monitor the System Event Log. 

 

In addition to a Java-based application GUI, hIOmon includes a “command line interface (CLI)” 

component that serves as an alternate means of control over the operation of hIOmon and of 

displaying, in a simple and efficient manner, a comprehensive set of file and device I/O 

operation performance metrics collected by hIOmon.  Several “Export” capability options are 

also provided that allow you to write the I/O trace and/or summarized performance metrics to a 

“Comma Separated Values (CSV)” file for use by spreadsheets (such as Microsoft® Excel), 

databases and other application programs (such as the MXG® Software from Merrill 

Consultants) so that you can easily perform your own specific analysis upon the performance 

metrics and generate customized charts and graphs.  The “I/O Trace” operation information 

selectively captured by hIOmon can also be exported to an XML-format file, which can be 

directly used (without conversion) by the “Intel® NAS Performance Toolkit” tools (both the 

NASPT Analyzer and the NASPT Exerciser). 

 

hIOmon additionally features support for Windows® Management Instrumentation (WMI).  

This support not only allows for programmatic control over the operation of hIOmon but also 

enables broad, industry-standard access to the robust set of file and disk I/O operation 

performance metrics uniquely collected by hIOmon.  The hIOmon real-time summarized file 

and disk I/O operation performance metrics can be accessed by simple scripts (including 

VBScript, JScript, and Perl), the Windows Script Host (WSH), Active Server Pages (ASP), 



Internet Explorer, and C/C++ applications along with a variety of management applications, such 

as Storage Resource Management (SRM) applications and the IBM® Tivoli® Monitoring 

solutions, that leverage WMI and the Common Information Model (CIM) standard.  The 

hIOmon software includes the “hIOmon WMI Browser” (an HTML application) that enables the 

simple use of Internet Explorer to easily control hIOmon operation and display the real-time 

summarized I/O operation performance metrics collected by hIOmon on a specific file, device, 

and/or process basis.   

 

hIOmon also provides a “Performance Extension DLL” (PerfLib) component that lets you use 

the Windows System Monitor (7/Vista™/XP/2003/2008) and other performance-monitoring 

applications to collect, display and further process the summarized I/O operation performance 

metrics which are observed, measured and monitored by hIOmon. 

 

The hIOmon monitoring facilities support sophisticated Alert capabilities as well.  Specific 

thresholds (such as maximum response time, average data transfer rate, I/O operations per 

second, etc.) can be set for selected file I/O operations; upon detection of these thresholds having 

been reached, hIOmon can optionally generate a System Event Log record (which in turn allows 

notification via system management tools that monitor the System Event Log).  

 

hIOmon allows you to quickly, easily and effectively answer the question:  

 

“How fast are your files?”™  

 

Features 

 

The many features provided by hIOmon include: 

 

Individual application/process, disk, and file-level perspectives. 

 

Specific file selection (along with options to explicitly include/exclude by specific 

process-name). 

 

Support for network-attached files. 

 

Raw device support (with a “Physical Device Extended Metrics” option). 

 

Support for Solid State Disk (SSD) related metrics (e.g., TRIM command usage). 

 

Selectable range of detail (e.g., “I/O trace” or “summarized”). 
 

Essential I/O performance statistics - at the individual file level, including “system file 

cache” metrics (e.g., “hit” and “miss” counts) along with sequential detection! 
 

Associated process name and account name – with summarized file I/O performance 

metrics available on a specific process basis. 

 



Precision time-stamps. 
 

Summary performance data on a periodic, close-file, or Alert basis. 
 

Alert capabilities for monitoring selected file I/O performance parameters. 
 

Easy-to-use, with both a Command-Line-Interface (CLI) along with a simple 

windows-type GUI display interface. 
 

Real-time and Replay display modes. 

 

Windows® Management Instrumentation (WMI) support, including the hIOmon 

WMI Browser and extensive scripting support. 

 

Provides support for the Microsoft Performance Monitor and System Monitor. 

 

Validated as “Ready for IBM Tivoli software”.  

 

Several export capabilities (including selectable export field options). 
 

Enables the easy and quick collection of selective I/O trace input files for direct use 

with the “Intel NAS Performance Toolkit (NASPT)”. 
 

Configurable startup options. 
 

Configurable setup options, including support for “Profiles”. 
 

Local or remote control/display over the network. 

 

hIOmon usage statistics. 

 

“Code-signed” (i.e., digitally-signed) installation files and Windows 7/Vista/2008 x64 

kernel-mode component. 
 

Extensive help information. 

 

Please refer to the “hIOmon User Guide” (HMG-1093) for more information about the many 

features listed above.  The “hIOmon User Guide” is included in the “Documents” directory as 

“hIOmonUserGuide.pdf”. 

 

 

 

 

 

 



Uses 

 

You can easily use the powerful features of hIOmon to quickly and effectively handle such tasks 

as:  

 

Identify files/devices with poor I/O performance. 

 

As the first step in analyzing performance problems with key applications, you can quickly 

use hIOmon to determine if the associated files are experiencing poor I/O operation 

performance (and to exactly what extent if so); you can even get summarized file I/O 

operation performance metrics upon a specific process basis. 

 

Impact of system changes upon file and device I/O performance. 

 

hIOmon allows you to determine the actual impact (with precise measurements as 

evidence) of changes within the computer system (such as the addition, replacement, or 

modification of:  disk subsystems, computer memory, file systems, processors, operating 

systems, etc.). 

 

Product/system comparisons, particularly amongst vendors. 

 

Without having to rely only upon benchmarks (and needing to correlate how closely these 

benchmarks match your particular applications), hIOmon allows you to use your actual 

applications and associated files just as you normally would with the products and/or 

systems that you want to compare (such as different disk subsystems, servers, etc., perhaps 

from different vendors) to see their effect on (even specific) file and device I/O operation 

performance. 

 

Monitor and confirm Quality of Service (QoS) for file I/O performance. 

 

hIOmon allows you to (independently) monitor the actual I/O operation activity of your 

(specific) files and devices; you can easily confirm whether these files and devices are 

meeting your expectations as regards I/O performance. 

 

Development and support aid   
 

For a broad range of developers and "troubleshooters" (including application developers 

concerned about file and device I/O performance; file system and device driver developers; 

disk subsystem developers; etc. - as well as for all of the respective associated support 

personnel), hIOmon provides an easy way of seeing exactly what (of interest) is happening 

in the file and device I/O activity (and if necessary, down to an I/O trace of the individual 

file and device I/O operations). 

  

With all of its features and benefits, hIOmon is “The I/O Speedometer and Odometer for your 

Files, Devices, and Applications”™ and is the essential tool required to help you qualify, 

validate, maintain and monitor the I/O operation performance of your files. 



 

Please send questions or comments about hIOmon to hIOmonSupportInfo@hyperIO.com. 

 

 

Architecture 

 

hIOmon features a very flexible and scalable architecture.  It is comprised of the following three 

(3) main components: 

 

    Presentation Client 

 

The hIOmon "Presentation Client" is a Java application that provides a standard 

windows-type graphical user interface (GUI).  This GUI communicates with the hIOmon 

Manager to set the various control options of the hIOmon I/O Monitor (such as which 

particular files/devices are to be monitored and the particular types of I/O operation 

performance metrics to be collected).  The Presentation Client is also used to display the 

collected file and device I/O operation performance statistics (in real-time or “replay” 

mode). 

 

     Manager 

 

The hIOmon "Manager" runs as an operating-system service (daemon).  It manages the 

hIOmon "I/O Monitor" component (largely based upon control option requests from or 

set by the hIOmon "Presentation Client"); it also transforms, records, and transfers the 

collected file and device I/O operation performance metrics to the "Presentation Client".  

The hIOmon "Manager" allows the "I/O Monitor" to be much more simpler, faster and 

efficient in operation. 

 

     I/O Monitor 

 

The hIOmon "I/O Monitor" is a lightweight component that performs the actual 

monitoring of the selected I/O operations; based upon such monitoring, it collects the 

requested I/O operation performance metrics.  The "I/O Monitor" is very efficient and 

introduces negligible overhead into the overall file and device I/O operation (especially 

when compared to the time durations of I/O operations); moreover, the “I/O Monitor” 

does not require any file system modifications nor does it require any operating system 

code changes (nor application or file changes).  

 

hIOmon also includes a hIOmon Command-Line-Interface (CLI) component, a hIOmon “WMI 

Support DLL” component (that provides Windows Management Instrumentation support) along 

with the “hIOmon WMI Browser”, a hIOmon “Performance Extension DLL” component (a 

“PerfLib” that provides Windows System Monitor support) and a hIOmon “Client 

Communication DLL” (that acts as an interface between the hIOmon Manager and the hIOmon 

CLI, hIOmon WMI, and Windows PerfMon/SysMon support components). 

 

 



1.4   OPERATING SYSTEMS AND ASSOCIATED SOFTWARE 

 

System requirements 

 

Note:  See the "Late-breaking news" section for more information on using and configuring the 

product in the Windows 7, Windows Vista, Windows XP, Windows Server 2003 and Windows 

Server 2008 operating system environments. 

 

     The hIOmon software has the following minimum system requirements: 

 

IBM PC (or 100% compatible); 

 

45 MB (megabytes) or more of free hard disk space (approximately 20 MB for the Sun 

Java Virtual Machine and 25 MB for the hIOmon software components at installation).  

Note that the Java Virtual Machine (JVM) is only required if the hIOmon Presentation 

Client GUI is used; Sun Java 2.0 Runtime Environment (JRE) Release 1.6.0 or higher is 

required for running the hIOmon Presentation Client upon the supported Windows 

operating system environments noted above. 

 

a 12X CD-ROM drive (for installation by means of a hIOmon Software Installation 

CD-ROM); 

 

Microsoft Windows 7/Vista/XP (Final Release or above) or Windows Server 2003/2008 

(Final Release or above). 

 

The Windows Management Instrumentation (WMI) Core 1.5 software package is 

required for the hIOmon “WMI Support”.  This WMI core software package is already 

installed by default on Windows 7/Vista/XP/2003/2008.  Internet Explorer version 5.5 or 

higher is required for use of the hIOmon WMI Browser. 

 

The Microsoft Visual C++ Runtime Libraries.  Note that these libraries can 

automatically be installed as part of the hIOmon software installation process. 

 

Pentium® 233 MHz or faster processor; 

 

64MB or more RAM (Windows XP), 128MB or more RAM (Windows Server 2003), 

512MB or more RAM (Windows 7/Vista/2008). 

 

 

Components 

 

The hIOmon software contains the following principal components: 

 

 Installer software –  

    Installs all of the other software files. 

 



hIOmon Presentation Client - 

Java application that provides a standard windows-type of graphical user interface 

(GUI), which is used to set the various control options of the hIOmon I/O monitor 

and to also display the collected file and device I/O operation performance 

metrics. 

 

hIOmon Manager - 

Runs as an operating-system service (or daemon).  It is used to manage the 

hIOmon I/O Monitor (largely based upon control option requests received from 

the hIOmon Presentation Client).  It also transforms, records, and transfers the 

collected file and device I/O operation performance metrics to the hIOmon 

“Presentation Client".              

 

 hIOmon I/O Monitor - 

Performs the actual monitoring of the selected file and device I/O operations; 

implemented as a "filter device driver" under Windows 7/Vista/XP/2003/2008. 

 

 hIOmon Command-Line-Interface (CLI) - 

Provides a “command-line-interface” for limited control over the operation of 

hIOmon and for the display of real-time summarized file and device I/O operation 

performance metrics. 

 

 hIOmon Windows Management Instrumentation (WMI) Support  DLL - 

A “WMI Support DLL” that provides the support required to interface with 

Windows Management Instrumentation (WMI). 

 

 hIOmon WMI Browser - 

Enables the use of Internet Explorer through WMI to control hIOmon operation 

and display real-time summarized file and device I/O operation performance 

metrics.  

 

 hIOmon Windows Performance Monitor / System Monitor PerfLib - 

A Windows “Performance Extension DLL” that provides the Windows 

Performance Monitor and System Monitor support. 

 

 hIOmon Client Communication Interface - 

Provides a common communication path between the hIOmon Manager and 

“clients” such as the hIOmon CLI component, hIOmon WMI component, and the 

hIOmon PerfLib component. 

 

 hIOmon Service Install - 

A utility program used to complete the load/unloading of the hIOmon Manager 

and hIOmon I/O Monitor service/driver programs. 

 

 

 



************************************ 

2.  LATE-BREAKING NEWS 

************************************ 

 

This section contains information that might impact the installation and use of the hIOmon 

product.  It also includes a brief description of new features incorporated in the latest version of 

hIOmon. 

 

NOTE:  All released hIOmon version components are General Availability (GA) versions of 

hIOmon.  If you encounter any errors or difficulties, please let us know by contacting hyperI/O 

LLC Technical Support (see section 6 for contact information). 

    

2.1   NEW FEATURES 

 

This new release (version 6.0.3850.0) of the hIOmon software includes enhancements to the 

hIOmon Manager Export Files (including the “Relative Time Stamp (RTS)” format option), 

which now can be provide specific details regarding the “Power IRPs” that have been monitored 

by the hIOmon I/O Monitor component.  These details include the type of Power IRP I/O 

operation along with the particular input parameter values that were specified by the respective 

Power IRP.  Please see the “hIOmon User Guide” document for additional information about 

the specific “Power IRP” details that can be captured and exported by the hIOmon software. 

 

Following from the prior release of the hIOmon software, the RTS format option provided by the 

hIOmon Manager Export Files allows the generation of an individual export record/row within 

the hIOmon Manager Export Files for each individual “Data Set Range (DSR)” associated with 

the SSD-related TRIM I/O operations.  That is, for each TRIM I/O operation, a separate export 

record/row is written for each individual DSR associated with the TRIM I/O operation (and with 

each such export record/row indicating both the corresponding starting offset and length for the 

respective DSR). 

 

This version of the hIOmon software also includes the enhanced “hIOmon SSD TRIM Metrics 

Display” gadget/HTA, which provides a simple and quick way to display a selected subset of the 

SSD TRIM-related metrics that can be captured by the hIOmon File I/O Performance Monitor.  

It can be run either as a Microsoft Windows Gadget (upon those systems that support the 

Windows Sidebar) and/or as a Windows HTML Application (HTA).  Please see the “hIOmon 

Add-On User Guide” document (HMG-1004) for additional details. 

 

This enhanced “hIOmon SSD TRIM Metrics Display” gadget/HTA additionally shows the total, 

cumulative number of bytes read from and written to the physical device/volume being 

displayed.  By reflecting the total number of bytes that have actually been transferred to/from 

the specific SSD by the host operating system, these two empirical metrics can be helpful when 

considering SSD performance (e.g., the impact of write I/O operations upon wear-leveling 

issues), endurance, etc. 

 

Please refer to the “hIOmon User Guide” (HMG-1093) for additional details about this new 

release of the hIOmon software package along with information about other recent enhancements 



and updates to the hIOmon File I/O Performance Monitor. 

 

Also please be sure to read the “Major How-To’s” chapter within the “hIOmon User Guide” 

document for brief answers to common questions related to the hIOmon software along with 

other considerations and recommendations regarding its operation and use.  And see the “Hints 

and Issues” section 4 below for additional suggestions about using the hIOmon software. 

 

2.2   KNOWN PROBLEMS 

 

None to report at this time.  Please report any problems to hyperI/O LLC (see section 6 for 

contact information). 

 

************************************ 

3.  OPERATION 

************************************ 

 

3.1   GETTING STARTED 

 

Once you have completed the installation of the hIOmon software, you can perform a simple set 

of basic steps to start using hIOmon.  Please refer to the steps described within the “Getting 

Started – Quick Start” section of the “hIOmon User Guide” (HMG-1093), which is included 

within the “Documents” directory as “hIOmonUserGuide.pdf”.  These steps show you how to 

start hIOmon file I/O monitoring and then display "real-time" I/O operation performance 

information for a selected set of files.  

 

A Quick-Start using the hIOmon Presentation Client is provided along with a Quick-Start using 

the hIOmon WMI Browser as well as the hIOmon “Automated Monitoring Configuration Setup 

Script”.  The hIOmon “Getting Started” FAQ html (accessible via the “Start -> Programs -> 

hIOmon -> Getting Started Help” shortcut) describes all of these Quick-Start procedures.  The 

Help menus of the hIOmon Presentation Client and the hIOmon WMI Browser also provide 

access to the respective Quick-Start instructions.  

 

Getting started with hIOmon using the “Quick Start” procedures to view the "real-time" 

performance information for selected file/device I/O operations is as easy as: 

 

I. Selecting the particular file/device I/O operation activities/metrics of interest. 

 

II. Viewing the corresponding I/O operation performance metrics in the format that you like. 

 

3.2 PRESENTATION CLIENT CONTROL AND DISPLAY DESCRIPTIONS 

 

As a Java-application, the hIOmon "Presentation Client" provides an easy-to-use method of 

controlling the overall operation of hIOmon and displaying, in a clear and organized fashion, the 

collected file and device I/O operation performance information.  It supports both real-time and 

“replay” mode displays. 

 



Please refer to the “hIOmon User Guide” (HMG-1093), which is included in the “Documents” 

directory as “hIOmonUserGuide.pdf”, for a complete description of the various Presentation 

Client control commands and display features. 

 

3.3 hIOmon WMI BROWSER CONTROL AND DISPLAY DESCRIPTIONS 

 

As an HTML application utilizing Internet Explorer and WMI, the hIOmon "WMI Browser" 

provides another easy-to-use method of controlling the overall operation of hIOmon and for 

displaying the real-time summarized file and device I/O operation performance metrics collected 

by hIOmon. 

 

Please refer to the “hIOmon User Guide” (HMG-1093), which is included in the “Documents” 

directory as “hIOmonUserGuide.pdf”, for a complete description of the various hIOmon WMI 

Browser control commands and display features. 

 

********************* 

4.  HINTS AND ISSUES 

********************* 

 

4.1   HINTS 

 

Attempting to monitor and view a large amount of I/O trace information in real-time mode can 

potentially degrade system performance (especially if the hIOmon Presentation Client is being 

run upon the same system that is being monitored by hIOmon).  Instead, and as a first step, use 

the hIOmon filters and summary capabilities (particularly the alert and file close options, along 

with the ability to arrange the summarized file and device I/O operation performance information 

in a particular order) to begin your observations of file/device I/O operation performance from 

the overall perspective (i.e., a “top-down” approach).  Then, based upon the I/O operation 

performance metrics provided by hIOmon, drill-down if necessary to the particular files/devices 

of interest.  Using the hIOmon “replay mode” facility can also aid performance as well as allow 

the ability to (repeatedly) study at a later time the I/O operation performance information 

collected by hIOmon. 

 

Also consider using the “hIOmon Add-Ons”, which provide a quick and easy way to configure 

the hIOmon software for collecting, exporting, and displaying file and device I/O operation 

performance metrics, especially when performing “top-down” file, device, and 

process/application I/O performance characterizations and/or determining the actual impact of 

file fragmentation upon file I/O operation performance. 

 

Also be sure to read the “Major How-To’s” chapter within the “hIOmon User Guide” document 

for brief answers to common questions related to the hIOmon software along with other 

considerations and recommendations regarding its operation and use.  And visit the hyperI/O 

LLC website for the latest “hIOmon Best Practices” information and the “Getting Started 

Tutorials”.   
 



4.2   SOFTWARE ISSUES 

 

     None to report. 

 

****************** 

5.  INSTALLATION 

****************** 

 

This section contains instructions for installing the hIOmon software under Windows 7, 

Windows Vista, Windows XP, Windows Server 2003, and Windows Server 2008. 

 

NOTE:  The hIOmon Presentation Client will run on Windows 7/Vista/XP/2003/2008; the 

hIOmon Manager and hIOmon I/O Monitor components likewise support Windows 7, Windows 

Vista, Windows XP, Windows Server 2003, and Windows Server 2008. 

 

See the "Hints and issues" section to solve issues that might occur when installing the software. 

 

 

5.1   INSTALLATION NOTES:  ALL MICROSOFT(R) WINDOWS PLATFORMS 

 

The hIOmon Installer software makes use of the Microsoft Windows Installer to perform the 

basic installation of the hIOmon software.  The hIOmon Installer software will automatically 

install the proper version of the Windows Installer if the Windows Installer is not found (in 

which case the computer system might require a reboot).  
 

 

 

5.2   INSTALLATION INSTRUCTIONS: WINDOWS 7/Vista/XP/2003/2008 

 

To install the hIOmon software on Windows 7/Vista/XP/2003/2008: 

 

1. If the "New Hardware Found" screen has opened, click Cancel. 

 

2. Quit all open programs. 

 

3. If you are installing from a CD-ROM, insert the hIOmon CD-ROM into the CD-ROM 

drive (usually D).  When the welcome screen opens, follow the instructions on the 

screen.  If the welcome screen does not open, click Start, and then Run.  Type X:Setup, 

replacing "X" with the letter of your drive, and click OK. 

 

If you are installing the downloaded version of the hIOmon software, click Start and then 

Run.   Open the “setup.exe” file that is located within the directory containing the 

downloaded hIOmon software (NOTE that you must first extract/unzip the downloaded 

hIOmon software).  When the welcome screen opens, follow the instructions on the 

screen. 

 



NOTE: To install the software on Windows 7/Vista/XP/2003/2008, you must log on with 

administrator privileges.  Also note that the hIOmon software installation files are 

“code-signed” (i.e., digitally-signed), which ensures that these files came from hyperI/O 

LLC and protects them from alteration after publication by hyperI/O LLC.  Finally note 

that if you had previously uninstalled the hIOmon software but not yet restarted the 

machine, then you must reboot the machine before attempting to re-install the hIOmon 

software. 

 

4. Follow the instructions on the screen.  When you are prompted for a serial number, 

please be sure to correctly enter the serial number from the CD-ROM label (or the serial 

number that you obtained from hyperI/O LLC if you are installing the downloaded 

version of the hIOmon software). 

 

The hIOmon Manager and hIOmon I/O Monitor software components must be loaded as 

services under Windows 7/Vista/XP/2003/2008.  The Windows Installer installation 

process provides several “Custom Installation Options”, one of which is to have the 

Windows Installer installation process automatically load (as part of the installation 

process) these hIOmon software components.  This “automatic load” installation option 

is a recommended option (and so is enabled by default). 

 

However, if you decide not to enable this “automatic load” installation option, then you 

must manually load the hIOmon Manager and hIOmon I/O Monitor software components 

before you can use the hIOmon software.  To manually load these hIOmon software 

components, click on the “Manually Load the hIOmon Manager and IO Monitor” 

shortcut found within the “hIOmonSI” directory where the hIOmon software was 

installed as part of the Windows Installer installation process.  Also note that on 

operating systems such as Windows 7, “administrator privilege” level must first be 

enabled prior to clicking on this shortcut.  This can be done by going to the shortcut 

using Windows Explorer, selecting the shortcut and then right-click, select the 

“Properties” menu option, click on the “Compatibility” tab, and then check the “Run this 

program as an administrator” checkbox under the “Privilege Level” section.  Then 

double-click on the shortcut to run the shortcut.  

 

In addition to loading the hIOmon Manager and hIOmon I/O Monitor software 

components as services under Windows 7/Vista/XP/2003/2008, the “load” process 

(whether invoked automatically as part of the Windows Installer installation process or 

manually thereafter) also uses the hIOmon “Service Installation” program to perform the 

following: 

 

Invoke the Windows 7/Vista/XP/2003/2008 Service Control Manager to immediately 

start both the hIOmon Manager and hIOmon I/O Monitor.  

 

Load/install the “performance counters” required to provide the “Windows® 

PerfMon/SysMon Support”. 

 

Compile/load the hIOmon WMI MOF file (into the WMI Repository) and register the 



hIOmonWMI DLL component, both of which are required for the hIOmon WMI 

Support. 

 

NOTE that the hIOmon Manager is loaded such that it will automatically be started when 

Windows 7/Vista/XP/2003/2008 starts.  While the hIOmon I/O Monitor is loaded such 

that it will not be automatically started by Windows 7/Vista/XP/2003/2008, the hIOmon 

Manager is configured by default (by the software installation process) so that the 

hIOmon Manager will automatically start its associated hIOmon I/O Monitor when the 

hIOmon Manager is started.  The hIOmon Presentation Client can also be used to 

manually start the hIOmon I/O Monitor (see the hIOmon Presentation Client “Actions -> 

Start/Stop Monitor” menu display) or enable/disable the hIOmon Manager’s automatic 

start of the hIOmon I/O Monitor when the hIOmon Manager is started (see the hIOmon 

Presentation Client “Edit –> Setup Options -> Monitor StartUp” menu display).  

Enabling/disabling the “automatic-start” of the hIOmon I/O Monitor by the hIOmon 

Manager can also be performed through the hIOmon WMI Browser. 

 

The Windows Installer installation process also provides a “Custom Installation Options” 

whereby you can run the hIOmon “Automated Monitoring Configuration Setup Script” as 

part of the Windows Installer installation process.  This VBScript enables you to easily 

and quickly configure the hIOmon software to monitor specific files of interest, to collect 

particular types of I/O operation metrics, and to export these metrics in real-time and 

within a CSV-format to specific hIOmon Manager Export Files.  This script also 

supports the “hIOmon Add-Ons” so that you can invoke a selected hIOmon Add-On 

immediately as part of the hIOmon software installation process.  Also note that this 

script can also be manually run after the Windows Installer installation process 

completes.  See the “Getting Started Help” information for additional details about this 

script. 

 

Another option provided by the “Custom Installation Options” is the “Install hIOmon 

Clients only” option.  This option enables you to install only the hIOmon Clients 

software (which includes the hIOmon Presentation Client, the hIOmon WMI Browser 

and WMI support, and the hIOmon CLI support) and without installing the hIOmon 

Manager and hIOmon I/O Monitor software components, which are required to actually 

collect the I/O operation performance metrics on the computer system.  The installed 

hIOmon Clients will, however, enable you to access a hIOmon Manager that is currently 

running upon another computer system, so that you can control the operation of the 

hIOmon software as well as access the I/O operation metrics collected by the hIOmon 

software upon that system.  

 

The setup takes a few minutes. When it is complete, remove the CD-ROM. 

 

Please check the System Event Log “Application Log” to see the results of the hIOmon 

software installation process.  

 

NOTE:  The hIOmon software installation process will not be able to successfully load 

and start the hIOmon I/O Monitor component if this hIOmon component is already 



running when the hIOmon “Service Installation” program is invoked to actually load this 

component as a service.  In this case, the hIOmon “Service Installation” program will 

add an entry to the System Event Log (Application Log) to report that it was unable to 

successfully load and start the hIOmon I/O Monitor component.  You must restart the 

operating system and then perform this step again for the hIOmon I/O Monitor 

component to be successfully loaded. 

 

5. If you intend to use the hIOmon Presentation Client (which is a Java application), then 

the computer upon which you run the hIOmon Presentation Client must have version 

1.6.0 or higher of the Java Runtime Environment (JRE) Java Virtual Machine (JVM) 

installed.  Note that the JVM is only required by the hIOmon Presentation Client; the 

hIOmon Manager, the hIOmon I/O Monitor and the hIOmon WMI Support components 

do not require the JVM to execute.  If you do not use the hIOmon Presentation Client or 

already have the required JRE JVM version installed, then you do not need to perform 

this step.  If you do need to install the JVM, then you can download the latest JVM from 

the Sun Java web (http://www.java.com/). 

 

6. Please read the “Read This First!!!” by using the “Start -> Programs -> hIOmon -> 

Getting Started Help -> Read This First!!!” shortcut, which will display a hIOmon Help 

html page that includes important information to help you get started using the hIOmon 

software. 

 

 

5.3   hIOmon DIRECTORY AND FILE DESCRIPTIONS 

 

The Windows Installer Setup program typically installs the hIOmon program files to the 

<device>:\Program Files\hyperIO\hIOmon directory.  

 

The hIOmon Manager (hIOmonGr.exe), the hIOmon I/O Monitor (hIOmonOn.sys) along with 

the two hIOmon “Windows® PerfMon/SysMon Support” components (the hIOmonPerfLib.dll 

and the hIOmonClientComm.dll) are all installed within the system directory.  The following 

subdirectories and files are installed under the \hIOmon directory with the Windows Installer 

setup program: 

 

Subdirectory\File      Description 

---------------------      ----------- 

hIOmonPC.jar       hIOmon Presentation Client 

..\Documents\readMe.pdf       hIOmon ReadMe document (HIR-1109) 

..\Documents\readMe.rtf     hIOmon ReadMe document 

..\Documents\readMe.txt     hIOmon ReadMe document (basic text file format) 

..\Documents\License.pdf      hIOmon License (EUSLA) document (HLA-1109) 

..\Documents\License.rtf     hIOmon License (EUSLA) document 

..\Documents\License.txt     hIOmon License (EUSLA) document in Text file format 

..\Documents\aCase4fileIOmonitorP.pdf hyperI/O white paper about file I/O performance 

monitoring (WP-1177)  

..\Documents\hIOmonDatasheet.pdf              hIOmon Datasheet (HMI-1090) 



..\Documents\hIOmonOverviewWithNotes.pdf  hIOmon Overview Presentation 

(HMP-1120) 

..\Documents\hIOmonUserGuide.pdf     hIOmon User Guide (HMG-1093) 

..\Documents\Help\DocumentationHelp.htm     hIOmon Documentation Help html 

..\Documents\Help\FAQs_Ask.htm      hIOmon FAQ submit html 

..\Documents\Help\FAQs_Index.htm     hIOmon FAQ index html 

..\Documents\Help\FAQs_Install.htm    hIOmon FAQs about Install html 

..\Documents\Help\FAQs_IOMonitor.htm    hIOmon FAQs about I/O Monitor html 

..\Documents\Help\FAQs_Manager.htm    hIOmon FAQs about Manager html 

..\Documents\Help\FAQs_PresClient.htm   hIOmon FAQs about Presentation Client 

html 

..\Documents\Help\AutoMonCfgSetupScriptHelp.htm hIOmon Automated Monitoring 

       Configuration Setup Script help html  

..\Documents\Help\GettingStartedHelp.htm    hIOmon Getting Started Help html 

..\Documents\Help\hIOmonBigPicture.htm     hIOmon Big Picture Overview html 

..\Documents\Help\WMIgettingStartedHelp.htm   hIOmon WMI Getting Started Help html 

..\Documents\Help\TooltipsHelp.htm    hIOmon Tool Tips Help html 

..\Support\AddOns        hIOmon “Add-Ons” directory 

       (see the ReadMe file within this directory for a list of the various Add-Ons and their use) 

..\Support\hIOmonCLI\hIOmonCLI.exe             hIOmon Command-Line-Interface exe 

..\Support\hIOmonCLI\readMe.txt              hIOmon CLI directory ReadMe 

..\Support\hIOmonGr\ExportFiles\readMe.txt Mgr Export Files directory ReadMe doc 

..\Support\hIOmonGr\FileIOlogs\readMe.txt  File I/O Log file directory ReadMe doc 

..\Support\hIOmonGr\FilterSL\readMe.txt  Filter Selection directory ReadMe doc 

..\Support\hIOmonGr\SampleAutoCfgInitFilters.hff Sample Automatic Configuration 

Initialization Filter Selection   

..\Support\hIOmonGr\hIOmonGrMsgs.dll hIOmon Manager System Event Log 

Message Support 

..\Support\hIOmonGr\readMe.txt   hIOmon Manager directory ReadMe 

..\Support\hIOmonOn\hIOmonOnMsgs.dll hIOmon I/O Monitor System Event Log 

Message Support 

..\Support\hIOmonPC\hIOmonPCprofiles\readMe.txt hIOmon Presentation Client “Profile” 

ReadMe file 

..\Support\hIOmonPC\hIOmonPC.prop hIOmon Presentation Client properties file   

..\Support\hIOmonPC\readMe.txt  hIOmon Presentation Client directory ReadMe   

..\Support\hIOmonPL\hIOmonCcMsgs.dll hIOmon Client Communication component 

Application Event Log Message Support 

..\Support\hIOmonPL\hIOmonPerfLib.ini hIOmon “PerfLib” component performance-counter 

initialization file 

..\Support\hIOmonPL\hIOmonPerfLibSymCtrs.h hIOmon “PerfLib” component 

performance-counter initialization support file 

..\Support\hIOmonPL\hIOmonPlMsgs.dll hIOmon “PerfLib” component Application Event 

Log Message Support 

..\Support\hIOmonSI\hIOmonSiMsgs.dll hIOmon Service Installation Utility System Event 

Log Message Support 

..\Support\hIOmonSI\ServiceInstall.exe hIOmon Service Installation Utility 



..\Support\hIOmonWMI\hIOmonWMI.dll  hIOmon WMI Support – WMI interface 

..\Support\hIOmonWMI\hIOmonWMImsgs.dll  hIOmon WMI Support Event Log Message 

Support 

..\Support\hIOmonWMI\hIOmonWMI.mof              hIOmon WMI MOF file 

..\Support\hIOmonWMI\hIOmonWMIunload.mof    hIOmon WMI file to unload MOF 

..\Support\hIOmonWMI\html\  hIOmon WMI Browser/help html directory 

..\Support\hIOmonWMI\html\hIOmonWMIbrowser.hta  hIOmon WMI Browser 

..\Support\hIOmonWMI\Scripting\Wsh\VBScript\           hIOmon WMI demo/sample scripts 

       (see the ReadMe file within this directory for a list of the various script files and their use) 

..\Support\images\Arrow.gif  hIOmon image file 

..\Support\images\ArrowReversed.gif     hIOmon image file 

..\Support\images\hIOmon.ico hIOmon image file 

..\Support\images\hIOmonCopyR.gif hIOmon image file 

..\Support\images\hIOmonIcon.jpg hIOmon image file 

..\Support\images\hIOmonLogo.jpg hIOmon image file 

..\Support\images\hIOmonSplashScreen.jpg  hIOmon image file 

..\Support\images\vendorLogo.gif  hIOmon image file 

..\Support\images\vendorName.gif  hIOmon image file 

..\Support\Updates\UpdateLog.txt hIOmon Update directory with an Update Activity 

Log document (UpdateLog.txt) 

 

5.4   Uninstalling the hIOmon software 

 

Use the Windows “Control Panel” to remove the hIOmon software.  Select “Add/Remove 

Programs” within the “Control Panel”, then select “hIOmon” within the list box and click on 

“Remove” to remove/uninstall the hIOmon software. 

 

As part of the uninstall process, the Windows Installer will automatically invoke the hIOmon 

“Service Installation” (ServiceInstall.exe) program, which in turn uses the Windows 

7/Vista/XP/2003/2008 Service Control Manager to unload the hIOmon Manager and hIOmon 

I/O Monitor components as services under Windows 7/Vista/XP/2003/2008; the hIOmon 

“Service Installation” utility will also automatically unload the “performance counters” (required 

to provide the “Windows PerfMon/SysMon Support”) and unload/remove the hIOmon WMI 

MOF file from the WMI Repository and un-register/unload the hIOmonWMI DLL component 

(both of which are required to provide the hIOmon WMI Support). 

 

NOTE:  The hIOmon Manager is first stopped prior to requesting that it be unloaded by the 

Windows 7/Vista/XP/2003/2008 Service Control Manager.  Also note that if the hIOmon I/O 

Monitor component is running at the time of this hIOmon Service Installation program 

invocation, then the hIOmon I/O Monitor will not be stopped and will continue to execute; the 

hIOmon I/O Monitor component will subsequently be unloaded/removed from the system when 

Windows 7/Vista/XP/2003/2008 is restarted.  If you subsequently decide to re-install the 

hIOmon software, then you must first restart the machine before attempting to re-install the 

hIOmon software (so that the hIOmon I/O Monitor component from the prior installation is 

completely removed before performing the re-installation of the hIOmon software).  

 



Please check the System Event Log “Application Log” to see the results of this hIOmon Service 

Installation program invocation.  

 

NOTE:  When the hIOmon software is uninstalled as described above, several subdirectories 

(and their contents) will remain within the directory into which the hIOmon software was 

installed (in addition to the “ProgramData” folder and any hIOmon folder that might be located 

within the VirtualStore folder on Windows Vista and later operating systems); see the 

“UpdateLog.txt” in the “Updates” subdirectory and the “readMe.txt” files in the following 

subdirectories for additional details:  hIOmonGr, ExportFiles, FileIOlogs, FilterSL, hIOmonPC, 

and hIOmonPCprofiles.  The “hIOmonPC.cfg” file will also remain in the 

..\hIOmon\Support\hIOmonPC directory; this file is generated and used by the hIOmon 

Presentation Client to maintain configuration information related to the use of the hIOmon 

Presentation Client.  You must manually delete this file (along with the files/folders mentioned 

above) to totally remove the hIOmon software package. 

 

Also note that any pre-requisite software (such as the Microsoft Visual C++ Runtime Libraries) 

installed by the Windows Installer as part of the hIOmon software installation process must be 

manually removed by separately using “Add/Remove Programs” within the “Control Panel”.  

The Windows Installer does not automatically remove the pre-requisite software as part of the 

“Remove hIOmon” software uninstall. 

 

********************************************************** 

6.  TECHNICAL ASSISTANCE AND SUPPORT INFORMATION 

********************************************************** 

 

6.1   OBTAINING ADDITIONAL INFORMATION FROM hyperI/O LLC 

 

The hyperI/O LLC website provides additional information about hIOmon (including technical 

assistance and support information).  You can also contact hIOmon Technical Support at 

hIOmonSupportInfo@hyperIO.com. 

 

6.2   OBTAINING INFORMATION VIA THE INTERNET 

 

The hyperI/O LLC website is located at www.hyperIO.com.  You can also reach hyperI/O LLC 

via the hIOmon website (located at www.hIOmon.com).  

 

6.3   ORDERING SOFTWARE 

 

To order additional copies of the software, contact hyperI/O LLC: 

 

        Request by Phone:   +1 303.415.2044 

 

        Request by Mail: hyperI/O LLC 

    4450 Arapahoe Avenue, Suite 100 

    Boulder, Colorado  80303-9102   USA 

 

http://www.hiomon.com/


************************ 

7.  LEGAL STATEMENTS 

************************ 

 

7.1   TRADEMARK NOTICES 

 

hyperI/O
sm

, hIOmon™, “How fast are your files?”™, and “The I/O Speedometer and Odometer 

for your Files, Devices, and Applications”™ are trademarks of hyperI/O LLC. 

 

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.  IBM® 

and Tivoli® are registered trademarks of the International Business Machines Corporation in the 

United States, other countries, or both.   The "Ready for IBM Tivoli software" mark and the 

trademarks contained therein are trademarks of IBM Corp.  IBM is not the licensor of this 

Business Partner's product and does not make any warranties regarding this Business Partner's 

product.  Intel® and Pentium® are U.S. registered trademarks of Intel Corporation. 

 

All trademarks mentioned herein are the property of their respective owners.   

 

7.2   LEGAL NOTICE 

 

Information provided in this document and the software called the "hIOmon" File I/O 

Performance Monitor is provided "as is".  No implied warranties of merchantability and or 

fitness for a particular purpose are given. 

 

Please read the hyperI/O LLC Software License Agreement (license.pdf) for the conditions and 

terms associated with the use of the hIOmon software product from hyperI/O LLC. 

 

7.3   COPYRIGHT 

 

     Copyright©  2000-2010   hyperI/O LLC.   All Rights Reserved. 

 

+++++++++++++++++++++++++++++++++++++++++++++++ 

****                        End of hIOmon ReadMe                      **** 
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